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Graphical User Interface

 So far all our interaction with the user has
been via terminal (System.in), command-

line arguments (args), and files

* We now look at the basics of GUlIs
(pronounced “gooey”) — graphical user
interfaces

— Window(s), menus, buttons, etc.
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« JavaFX is a relatively new framework for
developing Java GUI programs

 The JavaFX APl is an excellent example of
OOP

« JavaF X replaces older frameworks

— Abstract Window Toolkit (AWT): prone to
platform-specific bugs, original GUI framework

— Swing: replaced AWT, now superseded by
JavaFX
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JavaF X Features

* Runs on a desktop or from a Web browser

* Provides a multi-touch support for touch-
enabled devices (tablets and smart

phones)

* Has built-in 2D/3D animation support,
video and audio playback
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Your First JavaF X Project

* Create a new project in Eclipse
— Name: MyJavaFX

 Create a new class
— MydavaFX

« Extend the “Application” class
— Include a main method

public class MyJlavaFX extends Application {
public static void main(String[] args) {

}
}

JavaFX Basics
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Including JavaFX

« All JavaFX applications need the JavaFX runtime
library (jfxrt.jar) added to the class path (location
java looks for libraries)

* In Eclipse...
1. Right-click project, Properties
2. Java Build Path -> Libraries

3. Add External JARs

. Mac: /Library/Java/JavaVirtualMachines/jdk1.8.X_X.jdk/
Contents/Home/jre/lib/ext

. Windows:
C:\Program Files\Java\jdk1l.8.X X\jre\ext

4. Order and Export -> move jfxrt.jar to the top, OK

JavaFX Basics
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Screenshots (1)
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Screenshots (2)
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My First JavaF X Application

import javafx.
import javafx.
import javafx.
import javafx.
import javafx.

application.Application;
scene.Scene;
scene.control.Button;
scene.layout.StackPane;
stage.Stage;

public class MyJavaFX extends Application {
public static void main(String[] args) {
launch(args);

@Override
public void start(Stage primaryStage) {
primaryStage.setTitle("Hello World!");

final Button btn = new Button();
btn.setText("Click Me!");

final StackPane root = new StackPane();
root.getChildren().add(btn);

primaryStage.setScene(new Scene(root, 300, 250));
primaryStage.show();

}
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Platform-Independent GUI
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Basic Structure of JavaF X

1. Extend Application
2. launch(args) in

main <€— Stage
3. Override [ Scene
start (Stage) < Button
4. Populate
— Stage (Window):
primary=default, can

have multiple

— Scene; hierarchical
graph of nodes
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Multiple Windows

public void start(Stage primaryStage) {
Scene scene = new Scene(
new Button("OK"), 200, 250);
primaryStage.setTitle("MyJavaFX");
primaryStage.setScene(scene);
primaryStage.show(); 9
New Stage
Stage stage = new Stage();
stage.setTitle("Second Stage");
stage.setScene( u OK 3
new Scene(

new Button("New Stage"),
100, 100));

stage.show();

JavaFX Basics
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UML Relationships

Shapes such as Line, Circle,
—  Shape Ellipse, Rectangle, Path,
Stage Polygon, Polyline, and Text are
subclasses of Shape.

| ImageView | por displaying an image.

4@ Scene

Ul controls such as Label,
TextField, Button, CheckBox,

) RadioButton, and TextArea are
—  Node subclasses of Control.

—  Control

— FlowPane

<—— Stage

. T Iq L GridPane
- Scene

- Parent BorderPane

(Pane, Control) | | Pane m__ HBOX
]

- Nodes ?
— VBox

—— StackPane
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Revisit

import javafx.application.Application;
import javafx.scene.Scene;

import javafx.scene.control.Button;
import javafx.scene.layout.StackPane;
import javafx.stage.Stage;

public class MyJavaFX extends Application {
public static void main(String[] args) {
launch(args);

@Override
public void start(Stage primaryStage) {
primaryStage.setTitle("Hello World!");

final Button btn = new Button();
btn.setText("Click Me!");

final StackPane root = new StackPane(); // Forms the root of the nodes, organize vertically
root.getChildren().add(btn); // Add the button to the root

primaryStage.setScene(new Scene(root, 300, 250)); // Place the pane in the scene
primaryStage.show();

}

JavaFX Basics
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Another Example

public void start(Stage primaryStage) {

final Circle c¢ = new Circle(); .
|
c.setCenterX(100); O ® Circle!

.setCenterY(100); ;J
.setRadius(50);
.setStroke(Color.BLACK);
.setFill(Color.WHITE);

Nn N N0 0N

Pane pane = new Pane();
pane.getChildren().add(c);

Scene scene = new Scene(

pane, 200, 200); L
primaryStage.setTitle("Circle!");
primaryStage.setScene(scene);
primaryStage.show();

o 2N
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Notes

O @® Circle!

JJ X >
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Resizing the Window (

O © Circle!
3¢
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Solution 1: No Resizing

primaryStage.setResizable(false);
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Solution 2: Property Binding

« JavaFX introduces a new concept called
property binding that enables a target
object to be bound to a source object

* |f the value in the source object changes, the
target object is also changed automatically

* The target object is called a binding object or
a binding property and the source object is
called a bindable object or observable object

JavaFX Basics
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Example

public void start(Stage primaryStage) {
Pane pane = new Pane();

final Circle ¢ = new Circle();

C.
.setCenterY(100);
.setRadius(50);
.setStroke(Color.BLACK);
.setFill(Color.WHITE);

Nn n N N

C.
C.

pane.getChildren().add(c);
Scene scene = new Scene(pane, 200, 200);

primaryStage.setTitle("Circle!"); |
primaryStage.setScene(scene); +

primaryStage.show();

setCenterX(100);

centerXProperty().bind(pane.widthProperty().divide(2));
centerYProperty().bind(pane.heightProperty().divide(2));

PEESSERE e BRI N WD T . EN mEm L LU hj
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javafx.scene.paint.Color
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The getter methods for property
values are provided in the class, but
_— omitted in the UML diagram for brevity.

-red: double e

-green: double
-bTue: double
-opacity: double

The red value of this Color (between 0.0 and 1.0).
The green value of this Color (between 0.0 and 1.0).
The blue value of this Color (between 0.0 and 1.0).

The opacity of this Color (between 0.0 and 1.0).

+Color(r: double, g: double, b:
double, opacity: double)

+brighter(): Color
+darker(): Color

+color(r: double, g: double, b:
double): Color

+color(r: double, g: double, b:
double, opacity: double): Color

+rgb(r: int, g: int, b: int):
Color

+rgb(r: int, g: int, b: 1int,
opacity: double): Color

Creates a Color with the specified red. green. blue, and opacity values.

Creates a Color that is a brighter version of this Color.
Creates a Color that is a darker version of this Color.

Creates an opaque Color with the specified red, green, and blue values.
Creates a Color with the specified red, green, blue, and opacity values.

Creates a Color with the specified red. green, and blue values in the
range from O to 255.

Creates a Color with the specified red, green, and blue values in the
range from O to 255 and a given opacity.

JavaFX Basics
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Example

Rectangle recl =

new Rectangle(5, 5, 50, 40);
recl.setFill(Color.RED);
recl.setStroke(Color.GREEN);
recl.setStrokeWidth(3);

Rectangle rec2 =

new Rectangle(65, 5, 50, 40);
rec2.setFill(Color.rgb(91, 127, 255));
rec2.setStroke(

Color.hsb(40, 0.7, 0.8));
rec2.setStrokeWidth(3);

JavaFX Basics
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The Font Class

The getter methods for property
values are provided in the class, but

__— omitted in the UML diagram for brevity.
javafx.scene.text.Font ]
-size: double e The size of this font.
-name: String The name of this font.
-family: String The family of this font.
+Font(size: double) Creates a Font with the specified size.
+Font(name: String, size: Creates a Font with the specified full font name and size.
double)
+font(name: String, size: Creates a Font with the specified name and size.
double)
+font(name: String, w: Creates a Font with the specified name, weight, and size.
FontWeight, size: double)
+font(name: String, w: FontWeight, Creates a Font with the specified name, weight, posture, and size.
p: FontPosture, size: double)
+getFamilies(): List<String> Returns a list of font family names.
+getFontNames(): List<String> Returns a list of full font names including family and weight.
S —

JavaFX Basics
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Example

primaryStage.setTitle("Howdy!");

GridPane grid = new GridPane();
// grid.setGridLinesVisible(true);
grid.setAlignment(Pos.CENTER);
grid.setHgap(10); Howdy :)
gl"id . sethap(le); User Name: | user
grid.setPadding(new Insets(25, 25, 25, 25));
Password:

Text scenetitle = new Text("Howdy :)");
scenetitle.setFont(

Font.font("Tahoma", FontWeight.NORMAL, 20));
grid.add(scenetitle, 0, 0, 2, 1);

Label userName = new Label("User Name:");
grid.add(userName, 0, 1);

TextField userTextField = new TextField();
grid.add(userTextField, 1, 1);

Label pw = new Label("Password:");
grid.add(pw, 0, 2);

PasswordField pwBox = new PasswordField(); Howdy 1)
grid.add(pwBox, 1, 2);

User Namej | grid

Scene scene = new Scene(grid, 300, 275);
primaryStage.setScene(scene);
primaryStage.show();

Password: | [ eeeee

JavaFX Basics
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The Image Class

The getter methods for property
values are provided in the class, but

. . omitted in the UML diagram for brevity.
javafx.scene.image.Image
7
-error: ReadOnlyBooleanProperty 4 Indicates whether the image is loaded correctly?
-height: ReadOnlyBooleanProperty The height of the image.
-width: ReadOnlyBooleanProperty The width of the image.
-progress: ReadOnlyBooleanProperty The approximate percentage of image’s loading that is completed.
+Image(filenameOrURL: String) Creates an Image with contents loaded from a file or a URL.

JavaFX Basics
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The ImageView Class

javafx.scene.image.Image View

The getter and setter methods for property
values and a getter for property itself are provided
in the class, but omitted in the UML diagram for brevity.

P

-fitHeight: DoubleProperty
-fitWidth: DoubleProperty

-x: DoubleProperty

-y: DoubleProperty

-image: ObjectProperty<Image>

+ImageView()
+ImageView(image: Image)
+ImageView(filenameOrURL: String)

The height of the bounding box within which the image is resized to fit.
The width of the bounding box within which the image is resized to fit.
The x-coordinate of the ImageView origin.
The y-coordinate of the ImageView origin.

The 1mage to be displayed in the image view.

Creates an ImageView.

Creates an ImageView with the specified image.

Creates an ImageView with image loaded from the specified file or URL.

JavaFX Basics
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Example

primaryStage.setTitle("Load Image");

StackPane sp = new StackPane();

Image img = new Image(
"https://www.google.com/images/bra

nding/googlelogo/2x/googlelogo col
or_272x92dp.png");

ImageView imgView = new ImageView(img);
sp.getChildren().add(imgView);
Scene scene = new Scene(sp);

primaryStage.setScene(scene);
primaryStage.show();

Arcg < a

Google

K< s
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The MediaPlayer Class

The getter and setter methods for property \
values and a getter for property itself are provided
in the class, but omitted in the UML diagram for brevity.
Jjavafx.scene.media.MediaPlayer
/
-autoPlay: BooleanProperty i Specifies whether the playing should start automatically.
-currentCount: ReadOnlyIntegerProperty The number of completed playback cycles.
-cycleCount: IntegerProperty Specifies the number of time the media will be played.
-mute: BooleanProperty Specifies whether the audio is muted.
-volume: DoubleProperty The volume for the audio.
-totalDuration: The amount of time to play the media from start to finish.
ReadOnlyObjectProperty<Duration>
+MediaPlayer(media: Media) Creates a player for a specified media.
+play(): void Plays the media.
+pause(): void Pauses the media.
+seek(): void Seeks the player to a new playback time.

JavaFX Basics
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Example

MediaPlayer player;

@Override
public void start(Stage primaryStage) throws Exception {
final Button b = new Button("pause");
b.setOnAction(new EventHandler<ActionEvent>() { // more on this later!
@0verride
public void handle(ActionEvent event) {
if (player.getStatus()==Status.PAUSED) {
player.play();
b.setText("pause");
} else {
player.pause();
b.setText("play!");

1)

final StackPane sp = new StackPane();
sp.getChildren().add(b);

player = new MediaPlayer(new Media(getClass().getResource("flynn.mp3").toString()));
player.play();

primaryStage.setScene(new Scene(sp));
primaryStage.show();

JavaFX Basics
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« JavaF X provides many types of panes for
organizing nodes in a container

— Pane: base class

— FlowPane: row-by-row vertically, or column-by-
column horizontally

— BorderPane: top-right-left-bottom-center
— StackPane: stack vertically in the center
— GridPane: 2D grid

— HBox: single row

— VBox: single column

JavaFX Basics
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FlowPane
hGap Top side

I
_JL_ Y ~<— Pane

vGap ——l>¢ <— Right side

Left side —> i

Bottom side

I8 ShowFlowPane -ox|| FEXEL - o] x|
First Name: MI: First Name: MI:

Last Name: Last Name:
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@Override

FYI: Code

public void start(Stage primaryStage) throws Exception {
BorderPane pane = new BorderPane();

pane

pane.
pane.
pane.
pane.

.setTop(new CustomPane("Top"));

setRight(new CustomPane("Right"));
setBottom(new CustomPane("Bottom"));
setLeft(new CustomPane("Left"));
setCenter(new CustomPane("Center"));

Scene scene = new Scene(pane);
primaryStage.setTitle("ShowBorderPane");
primaryStage.setScene(scene);
primaryStage.show();

}

class CustomPane extends StackPane {
public CustomPane(String title) {

getChildren().add(new Label(title));
setStyle("-fx-border-color: red");
setPadding(new Insets(11.5, 12.5, 13.5, 14.5));

JavaFX Basics
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Shapes

Node |4— Shape ‘Q—— Text

Line

—— Rectangle

—  Circle

— Ellipse

— Arc

——  Polygon

L— Polyline

JavaFX Basics
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Text

The getter and setter methods for property values \
S,

and a getter for property itself are provided in the clas
. _ but omitted in the UML diagram for brevity.
javafx.scene.text. Text | ' -
- / e .
-text: StringProperty Defines the text to be displayed.
-x: DoubleProperty Defines the x-coordinate of text (default 0).
-y: DoubleProperty Defines the y-coordinate of text (default 0).
-underline: BooleanProperty Defines if each line has an underline below it (default false).
-strikethrough: BooleanProperty Defines if each line has a line through it (default false).
-font: ObjectProperty<Font> Defines the font for the text.
+Text() Creates an empty Text.
+Text(text: String) Creates a Text with the specified text.
+Text(x: double, y: double, Creates a Text with the specified x-, y-coordinates and text.
text: String)

(0, 0 (getWidth(), 0)

x, y) |

—— text is displayed

(0, getHeight()) (getWidth(), getHeight())

JavaFX Basics
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javafx.scene.shape.Line

Line

The getter and setter methods for property values
and a getter for property itself are provided in the class,

but omitted in the UML diagram for brevity.

-startX: DoubleProperty
-startY: DoubleProperty
-endX: DoubleProperty
-endY: DoubleProperty

+Line()

+Line(startX: double, startY:
double, endX: double, endY:
double)

Creates an empty Line.

The x-coordinate of the start point.
The y-coordinate of the start point.
The x-coordinate of the end point.

The y-coordinate of the end point.

Creates a Line with the specified starting and ending points.

JavaFX Basics
February 27, 2017

(0, 0 (getWidth(), 0)
(startX, startyY)
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(0, getHeight()) (getWidth(), getHeight())
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Rectangle

The getter and setter methods for property values
and a getter for property itself are provided in the class,

. but omitted in the UML diagram for brevity.
javafx.scene.shape.Rectangle — - )
A ]
-x: DoubleProperty The x-coordinate of the upper-left corner of the rectangle (default 0).
-y:DoubleProperty The y-coordinate of the upper-left corner of the rectangle (default 0).
-width: DoubleProperty The width of the rectangle (default: 0).
-height: DoubleProperty The height of the rectangle (default: 0).
-arcWidth: DoubleProperty The arcWidth of the rectangle (default: 0). arcWidth is the horizontal
diameter of the arcs at the corner (see Figure 14.31a).
-arcHeight: DoubleProperty The arcHeight of the rectangle (default: 0). arcHeight is the vertical
diameter of the arcs at the corner (see Figure 14.31a).
+Rectangle() Creates an empty Rectangle.
+Rectanlge(x: double, y: Creates a Rectangle with the specified upper-left corner point, width, and
double, width: double, height.
height: double)
aw/2
x, y)—>
ah/2 i vl ~N T
T +
<
=
[}
i -
\ M

~ width——
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Circle

/

The getter and setter methods for property values
and a getter for property itself are provided in the class,
__ but omitted in the UML diagram for brevity.

-centerX: DoubleProperty
-centerY: DoubleProperty
-radius: DoubleProperty

+Circle()
+Circle(x: double, y: double)

+Circle(x: double, y: double,
radius: double)

JavaFX Basics
February 27, 2017

The x-coordinate of the center of the circle (default 0).
The y-coordinate of the center of the circle (default 0).
The radius of the circle (default: 0).

Creates an empty Circle.

Creates a Circle with the specified center.

Creates a Circle with the specified center and radius.
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Ellipse

The getter and setter methods for property values
and a getter for property itself are provided in the class,
but omitted in the UML diagram for brevity.

javafx.scene.shape.Ellipse _
//

-centerX: DoubleProperty The x-coordinate of the center of the ellipse (default 0).
-centerY: DoubleProperty The y-coordinate of the center of the ellipse (default 0).
-radiusX: DoubleProperty The horizontal radius of the ellipse (default: 0).
-radiusY: DoubleProperty The vertical radius of the ellipse (default: 0).
+E1Tipse() Creates an empty E1Tipse.
+ET1lipse(x: double, y: double) Creates an E'111pse with the specified center.
+ET1ipse(x: double, y: double, Creates an E171 pse with the specified center and radiuses.

radiusX: double, radiusY:

double)

JavaFX Basics
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Arc (1)

The getter and setter methods for property values
and a getter for property itself are provided in the class,

. but omitted in the UML diagram for brevity.
javafx.scene.shape.Arc | )
//
-centerX: DoubleProperty The x-coordinate of the center of the ellipse (default 0).
-centerY: DoubleProperty The y-coordinate of the center of the ellipse (default 0).
-radiusX: DoubleProperty The horizontal radius of the ellipse (default: 0).
-radiusY: DoubleProperty The vertical radius of the ellipse (default: 0).
-startAngle: DoubleProperty The start angle of the arc in degrees.
-length: DoubleProperty The angular extent of the arc in degrees.
-type: ObjectProperty<ArcType> The closure type of the arc (ArcType.OPEN, ArcType.CHORD,
ArcType.ROUND).
+Arc() Creates an empty Arc.
+Arc(x: double, y: double, Creates an Arc with the specified arguments.
radiusX: double, radiusY:
double, startAngle: double,
Tength: double)

JavaFX Basics
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Arc (2)

length anc2: Opey arcl: round
startAngle
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radiusX radiusY
| @
Y M 3 s
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Polygon and Polyline

The getter and setter methods for property values
and a getter for property itself are provided in the class,

s e.Arc but omitted in the UML diagram for brevity.
-
/
+Polygpbn() Creates an empty Polygon.
+Polygon(double... points) Creates a Polygon with the given points.
+getPoints(): Returns a list of double values as x-and y-coordinates of the points.
ObservablelList<Double>
(40, 20), .
[~ (40, 20)
(70, 40) (70, 40)
(45, 45) 7 (45, 45) 7
(20, 60) \ / (20, 60)
(60, 80) (60, 80)
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e(fx)clipse

* Provides JavaFX tooling for the Eclipse
 http://www.eclipse.org/efxclipse/
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Installing e(fx)clipse (1)

&

C' ® www.eclipse.org/efxclipse/index.html

e(f)()CHpSe Home Install Releases References External Addons Community FXGraph Tutorials

e(fx)clipse

vaFX Tooling and Runtime for Eclipse and OSGi

About

Tooling

e(fx)clipse provides JavaFX tooling for the Eclipse IDE.

Runtime

It's not all about tooling in the e(fx)clipse project: we also
provide a runtime platform and libraries you can use in your

« JDT Support JavaFX 8 applications.

« PDE Support
« Ul DSL for authoring FXML « EMF Edit Ul for JavaFX

LI « Support for OSGi

« Support for the Eclipse 4 Application Platform

View details View details

Stay tuned
You can read about the latest developments on BestSolution's specific blog.

Are you looking for specific support?
Please check out our community section or visit also project's addons-channel. We are sure you'll find all answers needed there.

Tooling

JDT

[# Pac.. 2 = B

[3) MyApplicationjava 52

package example;

= T::UFX @ import javafx.applic
(8 src
1 example public class MyAppli
[ mya )
= JRE System | @verride

public void start(S

B JavaFX SDK s.setTitle("Hello

public static void
A i T L

Bug Tracker

Wiki Forum Project Info

Platforms

OpenJFX / JavaFX 8 is currently available on Windows, Mac
0OS X, and Linux as part of the OpenJDK 8 & Oracle JDK 8. Our
tooling supports all of these three platforms.

View details

By integrating into the Eclipse JDT, e.g., by providing a
specialized classpath container, e(fx)clipse allows users to
develop JavaFX applications in the same fashion they develop
Swing and SWT applications.
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Installing e(fx)clipse (2)

 Eclipse -> Help ->
Install New Software  [indow IS

Search
{2 Welcome

(?) Help Contents
%4 Search
Show Contextual Help

Show Active Keybindings... 4L
Tips and Tricks...

£/ Report Bug or Enhancement...

Cheat Sheets...

% Perform Setup Tasks...

% Check for Updates

3 Installation Details
2 Eclipse Marketplace...

JavaFX Basics
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Installing e(fx)clipse (3)

* Add location of
e(fx)clipse update site

» http://download.eclips  |sweerm
e.org/efxclipse/update | .
s-released/2.4.0/site e ]
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Installing e(fx)clipse (4)

» Select “e(fx)clipse -
install” -> “e(fx)clipse
- IDE”

Name Version
v [00 e(fx)clipse - install
4y e(fx)clipse - IDE 2.4.0.201605112122

» (00 e(fx)clipse - single components

Select All Deselect All 1 item selected
Details
Show only the latest versions of available software Hide items that are already irf
Group items by category What is already installed?

Show only software applicable to target environment

Contact all update sites during install to find required software
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Installing e(fx)clipse (9)

 Next

[ JOX ) Install

Install Details

Review the items to be installed.

W

Name Version Id
v Jte(fx)clipse - IDE 2.4.0.201605112122 org.eclipse.fx.ide.featur
P - e(fx)clipse - IDE - Basic 2.4.0.201605112122 org.eclipse.fx.ide.basic
3 e(fx)clipse - IDE - Converter 2.4.0.201605112122 org.eclipse.fx.ide.convi

> -ﬁ,e(fx)clipse - IDE - CSS 2.4.0.201605112122 org.eclipse.fx.ide.css.fi
g+ e(fx)clipse - IDE - DSL to setup JavaFX based code editors 2.4.0.201605112122 org.eclipse.fx.ide.ldef.f
P - e(fx)clipse - IDE - FXGraph 2.4.0.201605112122 org.eclipse.fx.ide.fxgra
P - e(fx)clipse - IDE - FXML 2.4.0.201605112122 org.eclipse.fx.ide.fxml.|
-ﬁ e(fx)clipse - IDE - GModel Feature 2.4.0.201605112122 org.eclipse.fx.ide.gmoc

e(fx)clipse - IDE - 110n support 2.4.0.201605112122 org.eclipse.fx.ide.[10n.
e(fx)clipse - IDE - Mobile 2.4.0.201605112122 org.eclipse.fx.ide.mobi
e(fx)clipse - IDE - PDE 2.4.0.201605112122 org.eclipse.fx.ide.pde.f
> - e(fx)clipse - IDE - RRobot 2.4.0.201605112122 org.eclipse.fx.ide.rrobc

Size: 73,506 KB

Details

@ < Back | Next> '} Cancel
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Installing e(fx)clipse (6)
* Agree, Finish

[ JOX ) Install

Review Licenses

Licenses must be reviewed and accepted before the software can be installed. N

Licenses: License text:
Eclipse Foundation Software User Agreement Eclipse Foundation Software User Agreement
April 9, 2014

Usage Of Content

THE ECLIPSE FOUNDATION MAKES AVAILABLE
SOFTWARE, DOCUMENTATION, INFORMATION AND/OR
OTHER MATERIALS FOR OPEN SOURCE PROJECTS
(COLLECTIVELY "CONTENT").

USE OF THE CONTENT IS GOVERNED BY THE TERMS
AND CONDITIONS OF THIS

AGREEMENT AND/OR THE TERMS AND CONDITIONS OF
LICENSE AGREEMENTS OR

NOTICES INDICATED OR REFERENCED BELOW. BY
USING THE CONTENT, YOU

AGREE THAT YOUR USE OF THE CONTENT IS
GOVERNED BY THIS AGREEMENT

AND/OR THE TERMS AND CONDITIONS OF ANY
APPLICABLE LICENSE AGREEMENTS

OR NOTICES INDICATED OR REFERENCED BELOW. IF
YOU DO NOT AGREE TO THE

TERMS AND CONDITIONS OF THIS AGREEMENT AND
THE TERMS AND CONDITIONS

© 1 accept the terms of the license agreement

| do not accept the terms of the license agreement

@ < Back Cancel ——
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Installing e(fx)clipse (7)
* Restart

@ Software Updates

You will need to restart Eclipse for the changes to take effect. Would you like to
restart now?

No [ Yes |

JavaFX Basics
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Using e(fx)clipse

* File -> New -> Project

JavaFX Basics
February 27, 2017

COMP1050 — Computer Science Il |

Spring 2017

Derbinsky

(] [ ] New Project

Select a wizard

Wizards:
type filter text

> (= General
> (= Gradle
> (= Java
¥ (= JavaFX
_| JavaFX Library Project
_| JavaFX Project
> (= 0sGI
> (= Samples
» (= Maven
» (= Plug-in Development
» (= Xtend
P (= Xtext
> (= Examples

= 0

53
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* A Visual Layout Tool for JavaF X Applications

* Quickly design JavaFX GUI via drag-and-
drop components that write an FXML file

« FXML file can be combined with a Java
project

 http://gluonhqg.com/products/scene-builder/
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Using SceneBuilder

e |nstall

* In Eclipse -> Preferences -> JavaFX
— Set path to SceneBuilder

* In Project, New -> Other -> JavaFX ->
New FXML Document

* Right click -> Open with SceneBuilder
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Example

Library Q @~ | [ BorderPane Inspector Q o
> Containers > Properties : BorderPane
v Controls v Layout : BorderPane
T ScrollBar (horizonta T
B scroliBar (vertical) Internal
== Separator (horizontal) [} ] o |
| Separator (vertical) Padding 50 >0 0 0
= Slider (horizontal) Size
¢ Slider (vertical)
@I SplitMenuButton Min Width USE_PREF_SIZE v
B TableColumn Min Height USE_PREF_SIZE v
B TableView Pref Width 600 v
— .
S N Pref Height 400
» VIl EaE Max Width USE_PREF_SIZE v
4 Shapes Max Height USE_PREF_SIZE v
> Charts Width
>
£z Height
Document =34
Position
v Hierarchy Click Me!!
-) [0 BorderPane Layout X 0
00 [ Label Yay!! ) Layout Y 0
1] |insert LEFT
Transforms
= Button Click Me!!!
[ |insert RIGHT Rotate 0
[ |insert BOTTOM
X Y z
Rotation Axis 0 0 1
Scale X 1
Scale Y 1
Scale Z 1
Translate X 0
Translate Y 0
2 Controller > Code : BorderPane
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Corresponding FXML

|J] MyJavaFX.java <> stuff.fxml 33 = E

1 <?xml version="1.0" encoding="UTF-8"7>
<?import javafx.geometry.*?>
<?import javafx.scene.text.*7?>

5 <?import javafx.scene.control.*?>

f <?import java.lang.*?>

' <?import javafx.scene.layout.*?>
<?import javafx.scene.layout.AnchorPane?>

11~ <BorderPane maxHeight="-Infinity" maxWidth="-Infinity" minHeight="-Infinity" minWidth="-Infinity" prefHeight
12 <center>
13 <Button mnemonicParsing="false" text="Click Me!!!" BorderPane.alignment="CENTER" />
14 </center>
15 <top>
6 <Label text="Yay!! :)" BorderPane.alignment="CENTER">
<font>
<Font name="Consolas Bold" size="36.0" />
</font>
0] </Label>
21 </top>
22 <padding>
23 <Insets top="50.0" />
24 </padding>
25 </BorderPane>
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Code

@Override

public void start(Stage primaryStage) throws Exception {
Parent root = FXMLLoader.load(getClass().getResource("stuff.fxml"));
Scene scene = new Scene(root);
primaryStage.setTitle("MyExampleApp");
primaryStage.setScene(scene);
primaryStage.show();
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Wentworth Institute of Technology

Potential Issue

* Update to latest JDK

E I . p
(mifd LSRR - AR =0 A Y P oy =5 &
[# Package Explorer 53 = = 8
.
» Eclipse -> Preferences
Installed JREs v v
Gradle
»Holp Add, remove or edit JRE definitions. By default, the checked JRE is added to the build path
of newly created Java projects.
> > » Install/Update
-> Java -> Installed
» Appearance
»Build Path Name Location Add.
» Code Style =\, Java SE 7[1.7.0_75] [Library/JavajJavaVirtualMachines/jck1.7.0.
J R E S » Compiler ¥ B Java SE 8 [1.8.0... [Library/Java/JavaVirtualMachines/jdk1.¢ Edit..
» Debug
» Editor =
» Installed JREs [ oK ) Edit JRE
Junit
Properties Files Editor JRE Definition
. » JavaFX Specify attributes for a JRE %
°Up dale It 10 1ales :
» Maven
> Mwe2
> Mylyn JRE home: [Library}Java/JavaVirtual 1.8.0_121.dk/C: ome Directory.
. »NLSDs!
» Oomph JRE name: Java SE 81.8.0_121]
version v
» RTask Default VM arguments: Variables
» Run/Debug JRE system libraries:
» Team { :
Validation ¥ (9 [Library/Java/J rtu 1.8.0_1271.jdk/C re/li jar Add External JARS. = [m
> XML » 4 [LibrarylJavafJavaVirtual 1.8.0_121.jdk/Cx omefireflibjrt.jar BB
» Xtend » (3 [Library}JavajJavaVirtualMachines/jdk1.8.0_121.jdk/Contents/Home/reflibjsse.jar 1
¥ Xtext ¥ (i [Library/J; JavaVirtual ines/jdk1.8.0_121.jdk/Ct firefliofjce.jar
> (4 [Library/JavajJavaVirtua 1.8.0.121.jdk/C omefire/li jar
» (3 [Library/JavajJavaVirtua 1.8.0_121.jdk/C: freflibfjfr.jar
» s [Library/Java/JavaVirtua 1.8.0_121.jdk/Cx omefjrefli jar
» a8 [Library/Java/JavaVirtualMachines/jdk1.8.0_121.jdk/Cx omefiref! jar
| | » @ fibrarysavajsavavirtua jdk1.8.0_121.jdk/Ct rellifextjj jar
» (4 [Library/JavajJavaVirtua 1.8.0.121.jdk/C lomefire/lifext/jfxrt.jar
» s [Library/JavajJavaVirtu 1.8.0_121.jdk/C: frefii ar
» s [Library/Java/JavaVirtua 1.8.0_121.jdk/Cx omefjrefli jar
» s [Library}Java/JavaVirtualMachines/jdk1.8.0_121.jdk/Cx omefiref! jar
» s [Library/Java/JavaVirtualMachines/jdk1.8.0_121.dk/Cx irefi :_providerja
Restore Default
Cancel

WARNING: Loading FXML document with JavaFX API of version 8.0.111

Exception in thread "Thread-1"
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Take Home Points

* You have now seen the basics of using
JavaF X for creating graphical user
interfaces (GUIs)

 Start playing around!
— This will be necessary for your project
— Install the tool(s) you plan to use

* More to come: how to respond to events (e.qg.
user clicks a button)
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